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1 Introduction

The verification grand challenge proposed by Prof. Tony Hoare sets the stage for the program
verification community to embark upon a collaborative effort to build verifiable programs. In
recent meetings it has been suggested that the community should concentrate on the verification
of the Linux kernel, but this would be an impossible task to do in a couple of years due to this
kernel’s size. So, Rajeev Joshi and Gerald Holzmann [3] decided to propose a “mini challenge”:
build a verifiable file system.

There are several reasons why a file system is more attractive as first target for verification.
Firstly, most modern file systems have a well-defined interface conforming to the POSIX standard.
Thus, writing a formal specification for a POSIX-compliant file system would require far less
effort than writing a kernel specification. Secondly, the algorithms and data structures used in file
system design are well understood and a verifiable file system implementation could be written
from scratch. Alternatively, researchers could choose an existing file system and attempt to verify
it. Thirdly, although file systems are only a small portion of an operating system, they are complex
enough for ensuring reliability in the presence of concurrent access, unexpected power or hardware
failure etc to be nontrivial. Finally, since almost all data on modern computers are now managed
by file systems, their correctness is of great importance, both from the standpoint of reliability as
well as security. Development of a verified file system would therefore be of great value.

Most modern file systems are written to comply with the POSIX standard for file systems.
This standard specifies a set of function signatures, along with a behavioral description of each
function. However, these behavioral descriptions are given as informal English prose, and are
therefore too ambiguous and incomplete to be useful in a verification effort. So we have writen a
formal specification of some POSIX standard functions (eg. mkdir, open, read, write) using the
modeling language VDM++ [9], although some features of the POSIX standard are not completely
modeled.

2 Analysis and Development

We divided this assignment in two steps. The first is the definition of data types and the
second the functions that manipulate them. We will first develop the functions in an algebric way.
After that, we’ll use these functions to build an object that will behave like a file system. To
help us on our work we used the requirements catalog available at the OLVER project [5]. From
all the requirements some were discharged due to the difficulty or extension of specifying them
in VDM. All requirements related with time, concurrency, special files (pipes, sockets, terminal
devices, etc.) and signals have been deliberately ”forgotten” in the current revion of the formal
model.

2.1 Data Types

The first step for the problem resolution is to define the necessary data types.

2.1.1 Tar

There are several ways of implementing a file system, for this assignment we used a non-
recursive version known as ’Tar’ or tape archive. It’s a ’map’ that has ’paths’ as keys and a ’file’
associated with each path. An invariant is added to enforce that all files and directories sub-paths
are present in ’Tar’ and sub-paths must be of directory type. Also a root is needed for Tar.
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class Tar

Id = char∗

inv id △

id 6= [] ∧
elems id ⊆ ({’-’, ’ ’, ’.’, ’(’, ’)’} ∪
{’0’, ’1’, ’2’, ’3’, ’4’, ’5’, ’6’, ’7’, ’8’, ’9’} ∪
{’a’, ’b’, ’c’, ’d’, ’e’, ’f ’, ’g’, ’h’, ’i’, ’j ’, ’k ’, ’l’, ’m’} ∪
{’n’, ’o’, ’p’, ’q’, ’r ’, ’s’, ’t’, ’u’, ’v ’, ’w ’, ’x ’, ’y’, ’z ’} ∪
{’A’, ’B ’, ’C ’, ’D’, ’E ’, ’F ’, ’G’, ’H ’, ’I ’, ’J ’, ’K ’, ’L’, ’M ’} ∪
{’N ’, ’O’, ’P ’, ’Q’, ’R’, ’S ’, ’T ’, ’U ’, ’V ’, ’W ’, ’X ’, ’Y ’, ’Z ’});

Path : :path : Tar ‘Id∗;

Tar = Tar ‘Path
m
→ Tar ‘File

inv tar △

∀ p ∈ dom tar ·
(subpaths (p) ⊆ (dom tar) ∧ ∀ x ∈ (subpaths (p)) · tar (x).attrib.type = d) ∧
(mk-Tar ‘Path ([]) ∈ dom tar ∧ tar (mk-Tar ‘Path ([])).attrib.type = d);

2.1.2 File

A ’file’ type is identified by it’s attribute (attrib.type) that may be the following values: a
regular file (<r>) , a directory (<d>), a link (<l>) , a socket (<s>), a character device file
special (<c>) or a block device special file (<b>). To simplify the problem we have chosen that
our function would only work with regular files, directories or links. User id and group id of the
owner as well as permission bits that indicate what permissions the owner, the group or others
have are also part of the file attributes. If the file is a directory the links fields indicates the number
of files or directories that directory contains. The size field indicates the total size of the file. The
dates field is divided into three other fields, representing the file last access (st atime), last data
modification (st mtime) and last i-node modification (st ctime). Each of these date fields contains
a date and a flag that shows if the date needs to be updated. The date can also be nil to cover
the case where it was still not update, for example, when a file or directory is created, it takes a
first update to fill the dates.

The file contents depends on which type the file is, if the file is a directory then the contents
is nil, in case of being a regular file, the contents is a ’map’ from address numbers to ’Byte’, if the
file is a link, the contents is the path that the link points and if type is block or character device,
the file contents indicates to what device is the file associated. An invariant was used in the type
’File’ to enforce that it is well formed concerning the file contents. The invariant is commented
because although it was working in VDM-SL, we had problems using it in VDM++ (maybe it’s a
VDM-tools bug).
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FileType = r | d | l | s | p | c | b;

FilePermissions : :user : Tar ‘Permissions

group : Tar ‘Permissions
other : Tar ‘Permissions;

Permissions : : read : B

write : B

exec : B;
UserId = N;
GroupId = N;

Attributes : : type : Tar ‘FileType
perm : Tar ‘FilePermissions
links : N

user : Tar ‘UserId
group : Tar ‘GroupId

size : N

dates : Dates;

Dates : : st-atime : Date
st-ctime : Date

st-mtime : Date;

Date : :date : [token]
update : B;

FileContents : : content : Tar ‘Memory;
Device = N;

File : : attrib : Tar ‘Attributes
contents : [Tar ‘FileContents | Tar ‘Path | Tar ‘Device];

2.1.3 System

To implement the functions we needed far more than only the ’Tar’ type. It was necessary
a type to model the operating system in which the file system is embedded. That type is the
’System’ and beside a filesystem ’Tar’ it also includes a table of the processes currently running on
the system, a file descriptor table, the actual process running on the system, the system constants,
the errno variable, the unused space of the file system, the system main memory and a table of
opened devices.

The process table contains various information regarding the processes that are running in the
system, like ownership (user id and group id), the file permission mask associated with process
and it’s used file descriptors.

The FileDescriptor associates a file descriptor (nat) with an OpenFileDescriptor (OFD), the
’OFD’ contains a path to a file, the status of the OFD (if ’append’ is set ), various flags used in
the implemented functions, the seek offset, the maximum offset supported by the system and the
mode that the file was opened (read, write, read & write).

The constants table contains the values of constants that are needed for the system to work.
The errno field is the field that holds the error message when a function fails.
The unused space field indicates how much free space the file system has.
The environment contains various flags that represent various situations that can happen in

the system, like if the system is unable to allocate resources or a socket. A field indicating what
mode is the file system mounted.
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Constants = char+
m
→ Z;

FileDescriptors = N
m
→ Tar ‘OpenFileDescriptor ;

OpenFileDescriptor : :file : Tar ‘Path
status : Flags-set
offset : N

maxoffset : N

flags : Tar ‘FDFlags-set
mode : rd | wr | rdwr;

FDFlags = FD CLOEXEC | ISIG | ICANON | IXON | ICRNL | IGNCR | INLCR;

ProcInfo : : userid : Tar ‘UserId

groupid : Tar ‘GroupId
umask : Tar ‘FilePermissions

usedfds : N-set;

Environment : : signal : B

unable2socket : B

unable2resorces : B

hangup : B

fsmode : rd | wr | rdwr

physicalerror : B;
Byte = char | Tar ‘Trash;
Trash = token;

Memory = N
m
→ Tar ‘Byte;

System : : tarFileSystem : Tar ‘Tar

process : N
m
→ ProcInfo

fds : Tar ‘FileDescriptors

actualproc : N

constants : Constants

errno : char∗

unusedspace : N

environment : Tar ‘Environment
memory : Tar ‘Memory

devices : Tar ‘Device
m
→ token

inv s △

s.actualproc ∈ dom s.process;

2.1.4 Mode t and Flags

Mode t These are flags to be used as arguments of mkdir and open functions and what they
mean is respectively:

• read, write, execute/search by owner

• read permission, owner

• write permission, owner

• execute/search permission, owner

• read, write, execute/search by group

• read permission, group

• write permission, group

• execute/search permission, group

• read, write, execute/search by others

• read permission, others

• write permission, others
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• execute/search permission, others

• set-user-ID on execution

• set-group-ID on execution

• on directories, restricted deletion flag

Mode-t = S IRWXU | S IRUSR | S IWUSR | S IXUSR | S IRWXG | S IRGRP | S IWGRP | S IXGRP |
S IRWXO | S IROTH | S IWOTH | S IXOTH | S ISUID | S ISGID | S ISVTX;

Flags These flags are to be used as argument to open and what they mean is respectively:

• Open for reading only

• Open for writing only

• Open for reading and writing

• Used with communications devices

• Used with communications devices

• Open at end of file for writing

• If set this results in write() calls not returning until data has actually been written to dics.

• Create the file if it doesn’t already exist

• If set and O CREAT set will cause open() to fail if the file already exists

• Truncate file size to zero if it already exists

• If the named file is a terminal device, don’t make it the controlling terminal for the process.

Flags = O RDONLY | O WRONLY | O RDWR | O NDELAY | O NONBLOCK | O APPEND | O SYNC |
O CREAT | O EXCL | O TRUNC | O NOCTTY

Other data types that were not mentioned are secondary and pretty self-explaining so we won’t
get into full details here.

2.2 Functions

2.2.1 Mkdir

mkdir NAME: mkdir – make a directory file

int mkdir(const char *path, mode_t mode);

[mkdir.01] The mkdir() function shall create a new directory with name path. [mkdir.02] The
file permission bits of the new directory shall be initialized from mode. [mkdir.03] These file
permission bits of the mode argument shall be modified by the process’ file creation mask [mkdir.04]
The directory’s user ID shall be set to the process’ effective user ID [mkdir.05] The directory’s group
ID shall be set to the group ID of the parent directory or to the effective group ID of the process.
Implementations shall provide a way to initialize the directory’s group ID to the group ID of the
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parent directory. Implementations may, but need not, provide an implementation-defined way to
initialize the directory’s group ID to the effective group ID of the calling process.

[mkdir.08] Upon successful completion, mkdir() shall mark fordd update the st atime, st ctime,
and st mtime fields of the directory. [mkdir.09] Also, the st ctime and st mtime fields of the
directory that contains the new entry shall be marked for update.

[mkdir.10] Upon successful completion, mkdir() shall return 0. [mkdir.11] Otherwise, -1 shall
be returned, no directory shall be created, and errno shall be set to indicate the error.

mkdir : Path × Mode-t-set × System → (Z × System)

mkdir (unresolvedpath,mode, sys) △

let proc = sys.process (sys.actualproc),
tar = sys.tarFileSystem,

fileperm = mode2perm (mode),
err = mkdirError (unresolvedpath, sys) in

if err 6= []
then mk- (− 1, µ (sys, errno 7→ err))
else let path = resolveLink (unresolvedpath, tar),

parent = tar (blast (path)),
date = mk-Tar ‘Dates

(
mk-Tar ‘Date (nil , true),
mk-Tar ‘Date (nil , true),
mk-Tar ‘Date (nil , true)),

newdir = mk-Tar ‘File

(
mk-Tar ‘Attributes (d,

applyMask (fileperm,proc.umask),
0, proc.userid,

proc.groupid,

1, date),
nil ),

newparentdates = mk-Tar ‘Dates

(
parent.attrib.dates.st-atime,

mk-Tar ‘Date (parent.attrib.dates.st-ctime.date, true),
mk-Tar ‘Date (parent.attrib.dates.st-mtime.date, true)),

pattrib = parent.attrib,

newparentattrib = mk-Tar ‘Attributes

(
pattrib.type,

pattrib.perm,

pattrib.links + 1,

pattrib.user ,

pattrib.group,

pattrib.size + 1,

newparentdates),
newparent = µ (parent, attrib 7→ newparentattrib) in

mk- (0, µ (sys,

tarFileSystem 7→ (sys.tarFileSystem †
{blast (path) 7→ newparent, path 7→ newdir})));

mkdirError This function perform error detection.
[mkdir.12] The mkdir() function shall fail if:

ENOENT [mkdir.12.06] A component of the path prefix specified by path does not name an
existing directory or path is an empty string.

ELOOP [mkdir.12.03] A loop exists in symbolic links encountered during resolution of the path
argument.

ENOTDIR [mkdir.12.08] A component of the path prefix is not a directory.

EACCES [mkdir.12.01] Search permission is denied on a component of the path prefix, or write
permission is denied on the parent directory of the directory to be created.
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EEXIST [mkdir.12.02] The named file exists.

EMLINK [mkdir.12.04] The link count of the parent directory would exceed LINK MAX.

ENAMETOOLONG [mkdir.12.05] The length of the path argument exceeds PATH MAX or a
pathname component is longer than NAME MAX.

ENOSPC [mkdir.12.07] The file system does not contain enough space to hold the contents of
the new directory or to extend the parent directory of the new directory.

ENOTDIR [mkdir.12.08] A component of the path prefix is not a directory.

EROFS [mkdir.12.09] The parent directory resides on a read-only file system.

[mkdir.13] The mkdir() function may fail if:

ELOOP [mkdir.13.01] More than SYMLOOP MAX symbolic links were encountered during res-
olution of the path argument.

ENAMETOOLONG [mkdir.13.02] As a result of encountering a symbolic link in resolution of
the path argument, the length of the substituted pathname string exceeded PATH MAX.

mkdirError : Path × System → char∗

mkdirError (unresolvedpath, sys) △

let proc = sys.process (sys.actualproc),
tar = sys.tarFileSystem,

c = sys.constants in
if (pathIsEmpty (unresolvedpath))
then "[ENOENT ]"
elseif (isLoop (unresolvedpath, tar))
then "[ELOOP ]"
elseif (symLoop (c ("{SYMLOOP MAX}")) (unresolvedpath, tar))
then "[ELOOP ]"
elseif (¬ isValidPath (blast (unresolvedpath), tar))
then "[ENOTDIR]"
else let path = resolveLink (unresolvedpath, tar) in

if (cannotAccess (path, tar , proc.userid,proc.groupid))
then "[EACCESS ]"
elseif (fileExists (path, tar))
then "[EEXIST ]"
elseif (isLinkFull (path, tar , c ("{LINK MAX}")))
then "[EMLINK ]"
elseif (isNameTooLong (path, c ("{PATH MAX}"), c ("{NAME MAX}")))
then "[ENAMETOOLONG]"
elseif (isNameTooLong (unresolvedpath, c ("{PATH MAX}"), c ("{NAME MAX}")))
then "[ENAMETOOLONG]"
elseif (notEnoughSpaceInFs (sys))
then "[ENOSPC ]"
elseif (prefIsNotDir (path, tar))
then "[ENOTDIR]"
elseif (isRdOnly (blast (path), tar , proc.userid,proc.groupid))
then "[EROFS ]"
else [];

[mkdir.07] If path names a symbolic link, mkdir() shall fail and set errno to [EEXIST].

isSymbolicLink : Tar ‘Path × Tar ‘Tar → B

isSymbolicLink (p, tar) △

if (p ∈ dom tar)
then tar (p).attrib.type = l

else false;

[mkdir.12.01] [EACCES] Search permission is denied on a component of the path prefix, or
write permission is denied on the parent directory of the directory to be created.
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cannotAccess : Tar ‘Path × Tar ‘Tar × Tar ‘UserId × Tar ‘GroupId → B

cannotAccess (path, tar , userid, groupid) △

(∃ p ∈ subpaths (path) ·
¬ checkExecPerm (p, tar , userid, groupid)) ∨

(¬ checkWritePerm (blast (path), tar , userid, groupid));

[mkdir.12.02] [EEXIST] The named file exists.

fileExists : Tar ‘Path × Tar ‘Tar → B

fileExists (p, tar) △

p ∈ dom tar ;

[mkdir.12.03] [ELOOP] A loop exists in symbolic links encountered during resolution of the
path argument.

isLoop : Tar ‘Path × Tar ‘Tar → B

isLoop (path, tar) △

if path.path = []
then false
else isLoopAux (mk-Tar ‘Path ([hd path.path]),

mk-Tar ‘Path (tl path.path), tar , {});

isLoopAux : Tar ‘Path × Tar ‘Path × Tar ‘Tar × Tar ‘Path-set → B

isLoopAux (resolve, rest, tar , accum) △

if resolve 6∈ dom tar
then false
else if (tar (resolve).attrib.type = l)

then let newpath = tar (resolve).contents in
if (newpath = resolve ∨ newpath ∈ accum)
then true
else cases newpath :

mk-Tar ‘Path ([]) →
isLoopAux (mk-Tar ‘Path ([]),

mk-Tar ‘Path (rest.path), tar , {}),
others → isLoopAux (mk-Tar ‘Path ([hd newpath.path]),

mk-Tar ‘Path (newpath.path y rest.path),
tar , {resolve} ∪ accum)

end
else if (tar (resolve).attrib.type = d)

then cases rest :
mk-Tar ‘Path ([]) → false,

others → isLoopAux
(
mk-Tar ‘Path (resolve.path y [hd rest.path]),
mk-Tar ‘Path (tl rest.path), tar , {})

end
else false;

[mkdir.12.04] [EMLINK] The link count of the parent directory would exceed LINK MAX.

isLinkFull : Tar ‘Path × Tar ‘Tar × N → B

isLinkFull (path, tar , link-max) △

tar (blast (path)).attrib.links > link-max

pre blast (path) ∈ dom tar

;

[mkdir.12.05] [ENAMETOOLONG] The length of the path argument exceeds PATH MAX or a
pathname component is longer than NAME MAX. [mkdir.13.02] [ENAMETOOLONG] As a result
of encountering a symbolic link in resolution of the path argument, the length of the substituted
pathname string exceeded PATH MAX.

isNameTooLong : Tar ‘Path × N × N → B

isNameTooLong (p, path-max ,name-max) △

len p.path ≥ path-max ∨ len last (p) > name-max ;
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[mkdir.12.06] [ENOENT] A component of the path prefix specified by path does not name an
existing directory or path is an empty string.

pathIsEmpty : Tar ‘Path → B

pathIsEmpty (path) △

path.path = [];

[mkdir.12.07] [ENOSPC] The file system does not contain enough space to hold the contents of
the new directory or to extend the parent directory of the new directory.

notEnoughSpaceInFs : System → B

notEnoughSpaceInFs (sys) △

sys.unusedspace = 0;

[mkdir.12.08] [ENOTDIR] A component of the path prefix is not a directory.

prefIsNotDir : Tar ‘Path × Tar ‘Tar → B

prefIsNotDir (path, tar) △

∃ p ∈ subpaths (path) · ¬ (tar (p).attrib.type = d);

[mkdir.12.09] [EROFS] The parent directory resides on a read-only file system.

isRdOnly : Tar ‘Path × Tar ‘Tar × N × N → B

isRdOnly (path, tar , userid, groupid) △

checkRDOnly (path, tar , userid, groupid)
pre path ∈ dom tar

;

[mkdir.13.01] [ELOOP] More than SYMLOOP MAX symbolic links were encountered during
resolution of the path argument.

symLoop : N → Tar ‘Path × Tar ‘Tar → B

symLoop (symloop-max)(path, tar) △

if path.path = []
then false
else verifySymLoop (symloop-max ,

mk-Tar ‘Path ([hd path.path]),
tar , 0,

mk-Tar ‘Path (tl path.path));

verifySymLoop : N × Tar ‘Path × Tar ‘Tar × N × Tar ‘Path → B

verifySymLoop (max ,path, tar , count, rest) △

if count = max

then true
else if path 6∈ dom tar

then false
else if tar (path).attrib.type = l

then let newpath = tar (path).contents in
cases newpath :

mk-Tar ‘Path ([]) →
verifySymLoop (max ,mk-Tar ‘Path ([]),

tar , count + 1,

mk-Tar ‘Path (rest.path)),
others → verifySymLoop (max ,

mk-Tar ‘Path ([hd newpath.path]),
tar , count + 1,

mk-Tar ‘Path (tl newpath.path y rest.path))
end

else cases rest :
mk-Tar ‘Path ([]) → false,

others → verifySymLoop (max ,

mk-Tar ‘Path (path.path y [hd rest.path]),
tar , count,
mk-Tar ‘Path (tl rest.path))

end;
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[mkdir.12.08] [ENOTDIR] A component of the path prefix is not a directory.

isValidPath : Tar ‘Path × Tar ‘Tar → B

isValidPath (path, tar) △

if path.path = []
then true
else isValidPathAux

(
mk-Tar ‘Path ([hd path.path]),
mk-Tar ‘Path (tl path.path), tar);

isValidPathAux : Tar ‘Path × Tar ‘Path × Tar ‘Tar → B

isValidPathAux (path, rest, tar) △

if path 6∈ dom tar

then false
else cases rest :

mk-Tar ‘Path ([]) → true,

others → let file = tar (path) in
if file.attrib.type = l

then isValidPathAux

(
mk-Tar ‘Path ([hd file.contents.path]),
mk-Tar ‘Path (tl file.contents.path y rest.path), tar)

else isValidPathAux

(
mk-Tar ‘Path (path.path y [hd rest.path]),
mk-Tar ‘Path (tl rest.path), tar)

end
pre path.path 6= []

;

This function perform a resolve link.
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resolveLink : Tar ‘Path × Tar ‘Tar → Tar ‘Path

resolveLink (p, tar) △

if p.path = []
then p
else resolveLinkAux

(
mk-Tar ‘Path ([hd p.path]),
mk-Tar ‘Path (tl p.path), tar)

pre if p.path 6= []
then isValidPath (blast (p), tar)
else true

;

resolveLinkAux : Tar ‘Path × Tar ‘Path × Tar ‘Tar → Tar ‘Path

resolveLinkAux (path, rest, tar) △

if path 6∈ dom tar

then path
else cases rest :

mk-Tar ‘Path ([]) →
if (tar (path).attrib.type = l)
then let newpath = tar (path).contents in

cases newpath :
mk-Tar ‘Path ([]) → mk-Tar ‘Path ([]),
others → resolveLinkAux

(
mk-Tar ‘Path ([hd newpath.path]),
mk-Tar ‘Path (tl newpath.path), tar)

end
else path,

others → if tar (path).attrib.type = l

then let newpath = tar (path).contents in
cases newpath :

mk-Tar ‘Path ([]) →
resolveLinkAux (mk-Tar ‘Path ([]), rest, tar),

others → resolveLinkAux

(
mk-Tar ‘Path ([hd newpath.path]),
mk-Tar ‘Path (tl newpath.path y rest.path), tar)

end
else resolveLinkAux

(
mk-Tar ‘Path (path.path y [hd rest.path]),
mk-Tar ‘Path (tl rest.path), tar)

end;

2.2.2 Rmdir

rmdir NAME: rmdir – remove a directory

int rmdir(const char *path);

[rmdir.01] The rmdir() function shall remove a directory whose name is given by path. [rmdir.06]
Upon successful completion, the rmdir() function shall mark for update the st ctime and st mtime
fields of the parent directory. [rmdir.07] Upon successful completion, the function rmdir() shall
return 0. [rmdir.08] Otherwise, -1 shall be returned, and errno set to indicate the error. If -1 is
returned, the named directory shall not be changed.

Department of Informatics 12 University of Minho



Verified File-System v1.0

rmdir : Path × System → (Z × System)

rmdir (unresolvedpath, sys) △

let tar = sys.tarFileSystem,

err = rmdirError (unresolvedpath, sys) in
if err 6= []
then mk- (− 1, µ (sys, errno 7→ err))
else let path = resolveLink (unresolvedpath, tar),

parent = tar (blast (path)),
newparentdates = mk-Tar ‘Dates

(
parent.attrib.dates.st-atime,

mk-Tar ‘Date (parent.attrib.dates.st-ctime.date, true),
mk-Tar ‘Date (parent.attrib.dates.st-mtime.date, true)),

pattrib = parent.attrib,

newparentattrib = mk-Tar ‘Attributes
(
pattrib.type,

pattrib.perm,

pattrib.links − 1,

pattrib.user ,

pattrib.group,

pattrib.size − 1,

newparentdates),
newparent = µ (parent, attrib 7→ newparentattrib) in

mk- (0, µ (sys,

tarFileSystem 7→ {path} −⊳ (sys.tarFileSystem †
{blast (path) 7→ newparent})));

rmdirError This function perform error detection.
[rmdir.90] The rmdir() function shall fail if:

EACCES [rmdir.90.01] Search permission is denied on a component of the path prefix, or write
permission is denied on the parent directory of the directory to be removed.

EBUSY [rmdir.90.02] The directory to be removed is currently in use by the system or some
process and the implementation considers this to be an error.

EEXIST or [ENOTEMPTY] [rmdir.90.03] The path argument names a directory that is not an
empty directory, or there are hard links to the directory other than dot or a single entry in
dotdot.

EINVAL [rmdir.90.04] The path argument contains a last component that is dot.

EIO [rmdir.90.05] A physical I/O error has occurred.

ELOOP [rmdir.90.06] A loop exists in symbolic links encountered during resolution of the path
argument.

ENAMETOOLONG [rmdir.90.07] The length of the path argument exceeds PATH MAX or a
pathname component is longer than NAME MAX.

ENOENT [rmdir.90.08] A component of path does not name an existing file, or the path argument
names a nonexistent directory or points to an empty string.

ENOTDIR [rmdir.90.10] A component of path is not a directory.

EPERM or [EACCES] [rmdir.90.11] The S ISVTX flag is set on the parent directory of the
directory to be removed and the caller is not the owner of the directory to be removed, nor is
the caller the owner of the parent directory, nor does the caller have the appropriate privileges.

EROFS [rmdir.90.12] The directory entry to be removed resides on a read-only file system.
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rmdirError : Path × System → char∗

rmdirError (unresolvedpath, sys) △

let proc = sys.process (sys.actualproc),
tar = sys.tarFileSystem,

c = sys.constants in
if (pathIsEmpty (unresolvedpath))
then "[ENOENT ]"
elseif (isLoop (unresolvedpath, tar))
then "[ELOOP ]"
elseif (symLoop (c ("{SYMLOOP MAX}")) (unresolvedpath, tar))
then "[ELOOP ]"
elseif (¬ isValidPath (blast (unresolvedpath), tar))
then "[ENOTDIR]"
else let path = resolveLink (unresolvedpath, tar) in

if (cannotAccess (path, tar , proc.userid,proc.groupid))
then "[EACCESS ]"
elseif (fileExists (path, tar))
then "[EEXIST ]"
elseif (isNameTooLong (path, c ("{PATH MAX}"), c ("{NAME MAX}")))
then "[ENAMETOOLONG]"
elseif (isNameTooLong (unresolvedpath, c ("{PATH MAX}"), c ("{NAME MAX}")))
then "[ENAMETOOLONG]"
elseif (prefIsNotDir (path, tar))
then "[ENOTDIR]"
elseif (isRdOnly (blast (path), tar , proc.userid,proc.groupid))
then "[EROFS ]"
else [];

[rmdir.91] The rmdir() function may fail if:

ELOOP [rmdir.91.01] More than SYMLOOP MAX symbolic links were encountered during res-
olution of the path argument.

ENAMETOOLONG [rmdir.91.02] As a result of encountering a symbolic link in resolution of
the path argument, the length of the substituted pathname string exceeded PATH MAX.

2.2.3 Unlink

unlink NAME: unlink – remove a directory entry

int unlink(const char * path);

[unlink.05] The unlink() function shall remove a link to a file. [unlink.06] If path names a
symbolic link, unlink() shall remove the symbolic link named by path and shall not affect any file
or directory named by the contents of the symbolic link. [unlink.07] Otherwise, unlink() shall
remove the link named by the pathname pointed to by path and shall decrement the link count of
the file referenced by the link [unlink.08] When the file’s link count becomes 0 and no process has
the file open, the space occupied by the file shall be freed and the file shall no longer be accessible
[unlink.09] If one or more processes have the file open when the last link is removed, the link shall
be removed before unlink() returns, but the removal of the file contents shall be postponed until
all references to the file are closed. [unlink.10] The path argument shall not name a directory
unless the process has appropriate privileges and the implementation supports using unlink() on
directories. [unlink.11] Upon successful completion, unlink() shall mark for update the st ctime
and st mtime fields of the parent directory. [unlink.12] Also, if the file’s link count is not 0, the
st ctime field of the file shall be marked for update. [unlink.13] Upon successful completion, 0
shall be returned. [unlink.14] Otherwise, -1 shall be returned and errno set to indicate the error.
[unlink.15] If -1 is returned, the named file shall not be changed.
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unlink : Path × System → (Z × System)

unlink (unresolvedpath, sys) △

let tar = sys.tarFileSystem,

err = unlinkError (unresolvedpath, sys) in
if err 6= []
then mk- (− 1, µ (sys, errno 7→ err))
else let path = resolveLink (unresolvedpath, tar),

parent = tar (blast (path)),
file = sys.tarFileSystem (path),
newparentdates = mk-Tar ‘Dates

(
parent.attrib.dates.st-atime,

mk-Tar ‘Date (parent.attrib.dates.st-ctime.date, true),
mk-Tar ‘Date (parent.attrib.dates.st-mtime.date, true)),

pattrib = parent.attrib,

newparentattrib = mk-Tar ‘Attributes

(
pattrib.type,

pattrib.perm,

pattrib.links − 1,

pattrib.user ,

pattrib.group,

pattrib.size − 1,

newparentdates),
newparent = µ (parent, attrib 7→ newparentattrib) in

if pathIsSLink (sys, path)
then mk- (0, µ (sys,

tarFileSystem 7→ {unresolvedpath} −⊳ (sys.tarFileSystem †
{blast (unresolvedpath) 7→ newparent})))

elseif file.attrib.links = 1
then mk- (0, µ (sys,

tarFileSystem 7→ {unresolvedpath,path} −⊳ (sys.tarFileSystem †
{blast (path) 7→ newparent})))

else let x1 = µ (sys,

tarFileSystem 7→ {unresolvedpath} −⊳ (sys.tarFileSystem †
{blast (unresolvedpath) 7→ newparent})),

newatrib = µ (file.attrib, links 7→ file.attrib.links − 1),
x2 = µ (file, attrib 7→ newatrib) in

mk- (0, µ (x1, tarFileSystem 7→ x1.tarFileSystem † {path 7→ x2}));

[PathIsSLink] The named file is a symbolic link.

pathIsSLink : System × Tar ‘Path → B

pathIsSLink (sys, path) △

if path 6∈ dom sys.tarFileSystem

then false
else let file = sys.tarFileSystem (path) in

(file.attrib.type = l);

unlinkError This function perform error detection.
[unlink.90] The unlink() function shall fail and shall not unlink the file if:

EACCES [unlink.90.01] Search permission is denied for a component of the path prefix, or write
permission is denied on the directory containing the directory entry to be removed.

EBUSY [unlink.90.02] The file named by the path argument cannot be unlinked because it is being
used by the system or another process and the implementation considers this an error.

ELOOP [unlink.90.03] A loop exists in symbolic links encountered during resolution of the path
argument.

ENAMETOOLONG [unlink.90.04] The length of the path argument exceeds PATH MAX or a
pathname component is longer than NAME MAX.
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ENOENT [unlink.90.05] A component of path does not name an existing file or path is an empty
string.

ENOTDIR [unlink.90.06] A component of the path prefix is not a directory.

EPERM [unlink.90.07] The file named by path is a directory, and either the calling process does
not have appropriate privileges, or the implementation prohibits using unlink() on directories.

EPERM or [EACCES] [unlink.90.08] The S ISVTX flag is set on the directory containing the
file referred to by the path argument and the caller is not the file owner, nor is the caller the
directory owner, nor does the caller have appropriate privileges.

EROFS [unlink.90.09] The directory entry to be unlinked is part of a read-only file system.

[unlink.92] The unlink() function may fail and not unlink the file if:

ELOOP [unlink.92.02] More than SYMLOOP MAX symbolic links were encountered during res-
olution of the path argument.

ENAMETOOLONG [unlink.92.03] As a result of encountering a symbolic link in resolution of
the path argument, the length of the substituted pathname string exceeded PATH MAX.

unlinkError : Path × System → char∗

unlinkError (unresolvedpath, sys) △

let proc = sys.process (sys.actualproc),
tar = sys.tarFileSystem,

c = sys.constants in
if (pathIsEmpty (unresolvedpath))
then "[ENOENT ]"
elseif (isLoop (unresolvedpath, tar))
then "[ELOOP ]"
elseif (symLoop (c ("{SYMLOOP MAX}")) (unresolvedpath, tar))
then "[ELOOP ]"
elseif (¬ isValidPath (blast (unresolvedpath), tar))
then "[ENOTDIR]"
else let path = resolveLink (unresolvedpath, tar) in

if (cannotAccess (path, tar , proc.userid,proc.groupid))
then "[EACCESS ]"
elseif (isNameTooLong (path, c ("{PATH MAX}"), c ("{NAME MAX}")))
then "[ENAMETOOLONG]"
elseif (isNameTooLong (unresolvedpath, c ("{PATH MAX}"), c ("{NAME MAX}")))
then "[ENAMETOOLONG]"
elseif (prefIsNotDir (path, tar))
then "[ENOTDIR]"
elseif (isRdOnly (blast (path), tar , proc.userid,proc.groupid))
then "[EROFS ]"
else [];

2.2.4 Remove

remove NAME: remove – remove a file or a directory file

int remove(const char *path);

[remove.01] The remove() function shall cause the file named by the pathname pointed to by path
to be no longer acessible by that name. [remove.02] A subsequent attempt to open that file using
that name shall fail, unless it is created a new. If path does not name a directory, remove(path)
shall be equivalent to unlink(path). If path names a directory, remove(path) shall be equivalent to
rmdir(path).
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remove : Path × System → (Z × System)

remove (unresolvedpath, sys) △

let tar = sys.tarFileSystem in
let path = resolveLink (unresolvedpath, tar) in
if pathIsDirectory (sys, path)
then rmdir (path, sys)
else unlink (path, sys);

[PathIsDirectory] The named file is a directory.

pathIsDirectory : System × Tar ‘Path → B

pathIsDirectory (sys, path) △

if path 6∈ dom sys.tarFileSystem

then false
else let file = sys.tarFileSystem (path) in

(file.attrib.type = d);

2.2.5 Open

Open [open.01] The open() function shall establish the connection between a file and a file de-
scriptor. It shall create an open file description that refers to a file and a file descriptor that refers
to that open file description. [open.02.01] The open() function shall return a file descriptor for
the named file that is the lowest file descriptor not currently open for that process. [open.02.02]
The open file description is new, and therefore the file descriptor shall not share it with any other
process in the system. [open.02.03] The FD CLOEXEC file descriptor flag associated with the
new file descriptor shall be cleared. [open.03] The file offset used to mark the current position
within the file shall be set to the beginning of the file. [open.04] The file status flags and file ac-
cess modes of the open file description shall be set according to the value of oflag. [app.open.104]
Values for oflag are constructed by a bitwise-inclusive OR of flags from the following list, defined
in <fcntl.h>.>Applications shall specify exactly one of the first three values (file access modes)
below in the value of oflag:O RDONLY Open for reading only. O WRONLY Open for writing
only. O RDWR Open for reading and writing. The result is undefined if this flag is applied to a
FIFO. [open.05] O APPEND If set, the file offset shall be set to the end of the file prior to each
write. [open.06.01] If the file exists, this flag has no effect except as noted under O EXCL below.
[open.06.02] Otherwise, the file shall be created; [open.06.03] the user ID of the file shall be set to
the effective user ID of the process; [open.06.04] the group ID of the file shall be set to the group ID
of the file’s parent directory or to the effective group ID of the process; [open.06.05] and the access
permission bits (see <sys/stat.h>) of the file mode shall be set to the value of the third argument
taken as type mode t modified as follows: a bitwise AND is performed on the file-mode bits and the
corresponding bits in the complement of the process’ file mode creation mask. Thus, all bits in the
file mode whose corresponding bit in the file mode creation mask is set are cleared. [open.13.01] If
the file exists and is a regular file, and the file is successfully opened O RDWR or O WRONLY,
its length shall be truncated to 0, and the mode and owner shall be unchanged. [open.13.02] It
shall have no effect on FIFO special files or terminal device files. [app.open.13.03] Its effect on
other file types is implementation-defined. [app.open.13.04] The result of using O TRUNC with
O RDONLY is undefined. [open.14] If O CREAT is set and the file did not previously exist, upon
successful completion, open() shall mark for update the st atime, st ctime, and st mtime fields of
the file and the st ctime and st mtime fields of the parent directory. [open.15] If O TRUNC is
set and the file did previously exist, upon successful completion, open() shall mark for update the
st ctime and st mtime fields of the file. [open.30.02] Otherwise, -1 shall be returned and errno set
to indicate the error. [open.30.03] No files shall be created or modified if the function returns -1.
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open : Tar ‘Path × Flags-set × Mode-t-set × System → (Z × System)

open (unpath, flags, mode-t, sys) △

let mode = mode2perm (mode-t),
tar = sys.tarFileSystem,

proc = sys.process (sys.actualproc),
err = openError (unpath, flags, sys) in

if err 6= []
then mk- (− 1, µ (sys, errno 7→ err))
else let path = resolveLink (unpath, sys.tarFileSystem) in

if (isRDWRFifo (sys, path, flags))
then mk- (− 1, sys)
else let ofd = createOfd (sys, path, flags),

fd = chooseFd (sys) in
if (O CREAT ∈ flags ∧ path 6∈ dom tar)
then let dates = mk-Tar ‘Dates

(
mk-Tar ‘Date (nil , true),
mk-Tar ‘Date (nil , true),
mk-Tar ‘Date (nil , true)),

file = mk-Tar ‘File (mk-Tar ‘Attributes (r,

applyMask (mode,proc.umask),1,

proc.userid,proc.groupid, 0, dates),
mk-Tar ‘FileContents ({7→})),

pdir = tar (blast (path)),
pattrib = pdir .attrib,

pdates = pattrib.dates,

npattrib = µ (pattrib, dates 7→ mk-Tar ‘Dates
(
pdates.st-atime,

mk-Tar ‘Date (pdates.st-ctime.date, true),
mk-Tar ‘Date (pdates.st-mtime.date, true))),

newpdir = µ (pdir , attrib 7→ npattrib),
newproc = µ (proc,usedfds 7→ proc.usedfds ∪ {fd}),
newsys = µ (sys, tarFileSystem 7→ tar † {path 7→ file, blast (path) 7→ newpdir},

fds 7→ sys.fds † {fd 7→ ofd},

process 7→ sys.process † {sys.actualproc 7→ newproc}) in
mk- (fd, newsys)

else if (path ∈ dom tar ∧ tar (path).attrib.type = r ∧
(O RDWR ∈ flags ∨ O WRONLY ∈ flags) ∧
O TRUNC ∈ flags)

then let file = tar (path),
fattrib = file.attrib,

fdates = fattrib.dates,

nfattrib = µ (fattrib, size 7→ 0, dates 7→ mk-Tar ‘Dates
(
fdates.st-atime,

mk-Tar ‘Date (fdates.st-ctime.date, true),
mk-Tar ‘Date (fdates.st-mtime.date, true))),

newfile = µ (file,

attrib 7→ nfattrib,

contents 7→ mk-Tar ‘FileContents ({7→})),
newproc = µ (proc,usedfds 7→ proc.usedfds ∪ {fd}),
newsys = µ (sys, tarFileSystem 7→ tar † {path 7→ newfile},

fds 7→ sys.fds † {fd 7→ ofd},

process 7→ sys.process † {sys.actualproc 7→ newproc}) in
mk- (fd, newsys)

else let newproc = µ (proc,usedfds 7→ proc.usedfds ∪ {fd}),
newsys = µ (sys, fds 7→ sys.fds † {fd 7→ createOfd (sys, path, flags)},

process 7→ sys.process † {sys.actualproc 7→ newproc}) in
mk- (fd, newsys);

[open.02.01] The open() function shall return a file descriptor for the named file that is the
lowest file descriptor not currently open for that process. [open.02.02] The open file description is
new, and therefore the file descriptor shall not share it with any other process in the system.
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chooseFd : Tar ‘System → N

chooseFd (sys) △

let used = usedFds (rng sys.process) in
chooseFDaux (0, used);

usedFds : Tar ‘ProcInfo-set → N-set
usedFds (s) △

if s = {}
then {}
else let proc ∈ s in

proc.usedfds ∪ usedFds (s \ {proc});

chooseFDaux : N × N-set → N

chooseFDaux (n, s) △

if n 6∈ s

then n
else chooseFDaux (n + 1, s);

[open.02.03] The FD CLOEXEC file descriptor flag associated with the new file descriptor shall
be cleared. [open.03] The file offset used to mark the current position within the file shall be set
to the beginning of the file. [open.04] The file status flags and file access modes of the open file
description shall be set according to the value of oflag. [open.19] The largest value that can be
represented correctly in an object of type off t shall be established as the offset maximum in the
open file description

createOfd : Tar ‘System × Tar ‘Path × Tar ‘Flags-set → Tar ‘OpenFileDescriptor

createOfd (sys, path, flags) △

let ofd = mk-Tar ‘OpenFileDescriptor (path, {}, 0, sys.constants ("{MAX OFFSET}"), {}, rd) in
open04 (ofd, flags);

open04 : Tar ‘OpenFileDescriptor × Tar ‘Flags-set → Tar ‘OpenFileDescriptor

open04 (ofd, flags) △

if O APPEND ∈ flags

then open04aux (µ (ofd, status 7→ ofd.status ∪ {O APPEND}), flags)
else open04aux (ofd, flags);

open04aux : Tar ‘OpenFileDescriptor × Tar ‘Flags-set → Tar ‘OpenFileDescriptor

open04aux (ofd, flags) △

if O RDONLY ∈ flags
then µ (ofd, mode 7→ rd)
else if O WRONLY ∈ flags

then µ (ofd, mode 7→ wr)
else µ (ofd, mode 7→ rdwr);

[app.open.104] The result is undefined if this flag is applied to a FIFO.

isRDWRFifo : Tar ‘System × Tar ‘Path × Tar ‘Flags-set → B

isRDWRFifo (sys, path, flags) △

if path ∈ dom sys.tarFileSystem

then sys.tarFileSystem (path).attrib.type = p ∧ O RDWR ∈ flags

else false;

openError [open.31] The open() function shall fail if:

ELOOP [open.31.07] A loop exists in symbolic links encountered during resolution of the path
argument.

ENOTDIR [open.31.14] A component of the path prefix is not a directory.

EEXIST [open.31.02] O CREAT and O EXCL are set, and the named file exists.

EINTR [open.31.03] A signal was caught during open().
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EISDIR [open.31.06] The named file is a directory and oflag includes O WRONLY or O RDWR.

EMFILE [open.31.08] OPEN MAX file descriptors are currently open in the calling process.

ENAMETOOLONG [open.31.09] The length of the path argument exceeds PATH MAX or a
pathname component is longer than NAME MAX.

ENFILE [open.31.10] The maximum allowable number of files is currently open in the system.

ENOENT [open.31.11] O CREAT is not set and the named file does not exist; or O CREAT is
set and either the path prefix does not exist or the path argument points to an empty string.

ENOSR [open.31.12] The path argument names a STREAMS-based file and the system is unable
to allocate a STREAM.

ENOSPC [open.31.13] The directory or file system that would contain the new file cannot be
expanded, the file does not exist, and O CREAT is specified.

ENXIO [open.31.15] O NONBLOCK is set, the named file is a FIFO, O WRONLY is set, and
no process has the file open for reading.

ENXIO [open.31.16] The named file is a character special or block special file, and the device
associated with this special file does not exist.

EOVERFLOW [open.31.17] The named file is a regular file and the size of the file cannot be
represented correctly in an object of type off t.

EROFS [open.31.18] The named file resides on a read-only file system and either O WRONLY,
O RDWR, O CREAT (if the file does not exist), or O TRUNC is set in the oflag argument.

[open.32] The open() function may fail if:

EINVAL [open.32.02] The value of the oflag argument is not valid.

ELOOP [open.32.03] More than SYMLOOP MAX symbolic links were encountered during reso-
lution of the path argument.

ENOMEM [open.32.05] The path argument names a STREAMS file and the system is unable to
allocate resources.
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openError : Tar ‘Path × Flags-set × System → char∗

openError (unpath, flags, sys) △

let c = sys.constants,

tar = sys.tarFileSystem in
if (isLoop (unpath, sys.tarFileSystem))
then "[ELOOP ]"
elseif (symLoop (c ("{SYMLOOP MAX}")) (unpath, tar))
then "[ELOOP ]"
elseif (unpath.path 6= [] ∧ (¬ isValidPath (blast (unpath), tar)))
then "[ENOTDIR]"
else let path = resolveLink (unpath, sys.tarFileSystem) in

if (open3114 (sys, path))
then "[ENOTDIR]"
elseif (open3101 (sys, path, flags))
then "[EACCESS ]"
elseif (open3102 (sys, path, flags))
then "[EEXIST ]"
elseif (open3103 (sys))
then "[EINTR]"
elseif (open3106 (sys, path, flags))
then "[EISDIR]"
elseif (open3108 (sys))
then "[EMFILE ]"
elseif (open3109 (sys, path))
then "[ENAMETOOLONG]"
elseif (open3110 (sys))
then "[ENFILE ]"
elseif (open3111 (sys, path, flags))
then "[ENOENT ]"
elseif (open3112 (sys, path))
then "[ENOSR]"
elseif (open3113 (sys, path, flags))
then "[ENOSPC ]"
elseif (open3115 (sys, path, flags))
then "[ENXIO]"
elseif (open3116 (sys, path))
then "[ENXIO]"
elseif (open3117 (sys, path))
then "[EOVERFLOW ]"
elseif (open3118 (sys, path, flags))
then "[EROFS ]"
elseif (open3202 (flags))
then "[EINVAL]"
elseif (open3205 (sys, path))
then "[ENOMEM ]"
else [];

[open.31.07] [ELOOP] A loop exists in symbolic links encountered during resolution of the path
argument. [open.32.03] [ELOOP] More than SYMLOOP MAX symbolic links were encountered
during resolution of the path argument. These functions are defined in the auxiliary functions

[open.31.14] [ENOTDIR] A component of the path prefix is not a directory.

open3114 : Tar ‘System × Tar ‘Path → B

open3114 (sys, path) △

prefIsNotDir (path, sys.tarFileSystem);

[open.31.01] [EACCES] Search permission is denied on a component of the path prefix, or the
file exists and the permissions specified by oflag are denied, or the file does not exist and write
permission is denied for the parent directory of the file to be created, or O TRUNC is specified and
write permission is denied.
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open3101 : System × Tar ‘Path × Flags-set → B

open3101 (sys, path, flags) △

let proc = sys.process (sys.actualproc) in
∃ p ∈ subpaths (path) ·

¬ checkExecPerm (p, sys.tarFileSystem, proc.userid, proc.groupid) ∨
if (path ∈ dom sys.tarFileSystem)
then ¬ checkFilePerm (sys, path, flags)
else ¬ checkWritePerm (blast (path), sys.tarFileSystem, proc.userid,proc.groupid) ∨

(O TRUNC ∈ flags∧¬ checkWritePerm (path, sys.tarFileSystem, proc.userid,proc.groupid));

[open.31.02] [EEXIST] O CREAT and O EXCL are set, and the named file exists.

open3102 : System × Tar ‘Path × Flags-set → B

open3102 (sys, path, flags) △

O CREAT ∈ flags ∧
O EXCL ∈ flags ∧
path ∈ dom sys.tarFileSystem;

[open.31.03] [EINTR] A signal was caught during open().

open3103 : System → B

open3103 (sys) △

sys.environment.signal;

[open.31.06] [EISDIR] The named file is a directory and oflag includes O WRONLY or O RDWR.

open3106 : System × Tar ‘Path × Flags-set → B

open3106 (sys, path, flags) △

if path 6∈ dom sys.tarFileSystem
then false
else let file = sys.tarFileSystem (path) in

(file.attrib.type = d) ∧ (O WRONLY ∈ flags ∨ O RDWR ∈ flags);

[open.31.08] [EMFILE] OPEN MAX file descriptors are currently open in the calling process.

open3108 : System → B

open3108 (sys) △

let proc = sys.process (sys.actualproc) in
sys.constants ("{OPEN MAX}") = card proc.usedfds;

[open.31.09] [ENAMETOOLONG] The length of the path argument exceeds PATH MAX or a
pathname component is longer than NAME MAX.

open3109 : Tar ‘System × Tar ‘Path → B

open3109 (sys, path) △

let rpath = resolveLink (path, sys.tarFileSystem),
c = sys.constants in

if path.path = []
then false
else isNameTooLong (rpath, c ("{PATH MAX}"), c ("{NAME MAX}"))

pre if (path.path 6= [])
then isValidPath (blast (path), sys.tarFileSystem)
else true

;

[open.31.10] [ENFILE] The maximum allowable number of files is currently open in the system.

open3110 : System → B

open3110 (sys) △

let c = sys.constants in
card usedFds (rng sys.process) = c ("{MAX OPEN SYSTEM}");
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[open.31.11] [ENOENT] O CREAT is not set and the named file does not exist; or O CREAT
is set and either the path prefix does not exist or the path argument points to an empty string.

open3111 : System × Tar ‘Path × Flags-set → B

open3111 (sys, path, flags) △

(O CREAT 6∈ flags ∧ path 6∈ dom sys.tarFileSystem) ∨
(O CREAT ∈ flags ∧ (path.path = [] ∨ (blast (path) 6∈ dom sys.tarFileSystem)));

[open.31.12] [ENOSR] The path argument names a STREAMS-based file and the system is
unable to allocate a STREAM.

open3112 : Tar ‘System × Tar ‘Path → B

open3112 (sys, path) △

if path ∈ dom sys.tarFileSystem
then sys.tarFileSystem (path).attrib.type = s ∧ sys.environment.unable2socket
else false;

[open.31.13] [ENOSPC] The directory or file system that would contain the new file cannot be
expanded, the file does not exist, and O CREAT is specified.

open3113 : Tar ‘System × Tar ‘Path × Flags-set → B

open3113 (sys, path, flags) △

sys.unusedspace = 0 ∨
if path.path 6= []
then (path 6∈ dom sys.tarFileSystem ∧

O CREAT ∈ flags ∧
isLinkFull (path, sys.tarFileSystem, sys.constants ("{LINK MAX}")))

else false
pre if path.path = []

then true
else blast (path) ∈ dom sys.tarFileSystem

;

[open.31.15] [ENXIO] O NONBLOCK is set, the named file is a FIFO, O WRONLY is set,
and no process has the file open for reading.

open3115 : Tar ‘System × Tar ‘Path × Flags-set → B

open3115 (sys, path, flags) △

O NONBLOCK ∈ flags ∧
sys.tarFileSystem (path).attrib.type = p ∧
O WRONLY ∈ flags ∧
¬∃ fd ∈ rng sys.fds · fd.file = path ∧ fd.mode = rd;

[open.31.16] [ENXIO] The named file is a character special or block special file, and the device
associated with this special file does not exist.

open3116 : Tar ‘System × Tar ‘Path → B

open3116 (sys, path) △

if path ∈ dom sys.tarFileSystem

then let file = sys.tarFileSystem (path) in
if (file.attrib.type = c ∨ file.attrib.type = b)
then file.contents 6∈ dom sys.devices
else false

else false;

[open.31.17] [EOVERFLOW] The named file is a regular file and the size of the file cannot be
represented correctly in an object of type off t.

open3117 : Tar ‘System × Tar ‘Path → B

open3117 (sys, path) △

if path ∈ dom sys.tarFileSystem

then let file = sys.tarFileSystem (path) in
file.attrib.type = r ∧ file.attrib.size > sys.constants ("{MAX OFF T}")

else false;
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[open.31.18] [EROFS] The named file resides on a read-only file system and either O WRONLY,
O RDWR, O CREAT (if the file does not exist), or O TRUNC is set in the oflag argument.

open3118 : Tar ‘System × Tar ‘Path × Tar ‘Flags-set → B

open3118 (sys, path, flags) △

(O WRONLY ∈ flags ∨
O RDWR ∈ flags ∨
(O CREAT ∈ flags ∧ path 6∈ dom sys.tarFileSystem) ∨
O TRUNC ∈ flags) ∧

sys.environment.fsmode = rd;

[open.32.02] [EINVAL] The value of the oflag argument is not valid.

open3202 : Tar ‘Flags-set → B

open3202 (flags) △

card {x | x ∈ flags · x = O RDONLY ∨ x = O WRONLY ∨ x = O RDWR} > 1 ∨
(O EXCL ∈ flags ∧ O CREAT 6∈ flags) ∨
({O TRUNC, O RDONLY} ⊆ flags);

[open.32.05] [ENOMEM] The path argument names a STREAMS file and the system is unable
to allocate resources.

open3205 : Tar ‘System × Tar ‘Path → B

open3205 (sys, path) △

if path ∈ dom sys.tarFileSystem
then sys.tarFileSystem (path).attrib.type = s ∧ sys.environment.unable2resorces
else false;

2.2.6 Read

read read input
[read.01] The read() function shall attempt to read nbyte bytes from the file associated with the

open file descriptor, fildes, into the buffer pointed to by buf. [read.03] Before any action described
below is taken, and if nbyte is zero, the read() function may detect and return errors as described
below. [read.04] In the absence of errors, or if error detection is not performed, the read() function
shall return zero and have no other results.

[read.05] On files that support seeking (for example, a regular file), the read() shall start at a
position in the file given by the file offset associated with fildes. [read.06] The file offset shall be
incremented by the number of bytes actually read. [read.07] Files that do not support seeking - for
example, terminals - always read from the current position. [read.08] If the starting position is
at or after the end-of-file, 0 shall be returned. [app.read.51] If the value of nbyte is greater than
SSIZE MAX, the result is implementation-defined.

OBS: The file types that support or don’t seeking are not mentioned. We consider that only
the regular files support seeking. This is not an important aspect because the function is prepared
only to deal with regular files.

[app.read.51] If the value of nbyte is greater than SSIZE MAX, the result is implementation-
defined.

OBS: We choose not to read any byte if this condition is true.
[read.13.01] Upon successful completion, where nbyte is greater than 0, read() shall mark for

update the st atime field of the file [read.13.02] and shall return the number of bytes read. This
number shall never be greater than nbyte. [read.14] The value returned may be less than nbyte
[read.14.01] if the number of bytes left in the file is less than nbyte, [read.41.01] Upon successful
completion, read() and pread() shall return a non-negative integer indicating the number of bytes
actually read. [read.85] The minimum of either the number of bytes requested or the number
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of bytes currently available shall be returned without waiting for more bytes to be input. If no
characters are available, read() shall return a value of zero, having read no data.

OBS: Doesn’t mention if the return value must be the number of red bytes or the number of
bytes to be put on buf. These values could be different so we choose to return the number of bytes
red from the file.

OBS: Acording to [read.68.01], there is one more situation in which the return value is less
then nbyte.

read : System × N × N × N → Z × System

read (sys, filedes, buf , nbyte) △

let err = readError (sys, filedes,nbyte) in
if err 6= []
then mk- (− 1, µ (sys, errno 7→ err))
else let fileContents = getFileContents (sys, filedes),

file = getFile (sys, filedes),
fd = sys.fds (filedes),
offset = getOffset (sys, filedes),
maxoffset = getMaxOffset (sys, filedes),
constants = sys.constants,

flags = fd.flags in
if nbyte = 0
then mk- (0, sys)
else let startd = if isRegularFile (file)

then offset

else 0 in
if startAtEOF (fileContents, startd)
then mk- (0, sys)
elseif gNByte (constants, filedes)
then mk- (0, sys)
else let mk- (data, newoffset) = readFile (fileContents, flags, startd, nbyte, maxoffset) ([]),

bytesRead = newoffset − offset,

sys1 = setOffset (sys, filedes,newoffset),
sys2 = setSt-ATime (sys1, filedes),
res = bytesRead,

sys3 = setMemory (sys2, buf , data) in
mk- (res, sys3)

pre getFile (sys, filedes).attrib.type = r

;

This function verify if a file is regular.

isRegularFile : File → B

isRegularFile (file) △

file.attrib.type = r;

This function verify if the starting position is at or after the end-of-file.

startAtEOF : FileContents × N → B

startAtEOF (filecont, startd) △

startd ≥ max (dom filecont.content);

This function verify if the value of nbyte is greater than SSIZE MAX.

gNByte : Constants × N → B

gNByte (consts, nbyte) △

nbyte > consts ("SSIZE MAX");

readError performs error detection
[read.42] The read() and pread() functions shall fail if:

EBADF [read.42.02] The fildes argument is not a valid file descriptor open for reading.
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EISDIR [read.42.07] The fildes argument refers to a directory and the implementation does not
allow the directory to be read using read() or pread(). The readdir() function should be used
instead.

EOVERFLOW [read.42.08] The file is a regular file, nbyte is greater than 0, the starting posi-
tion is before the end-of-file, and the starting position is greater than or equal to the offset
maximum established in the open file description associated with fildes.

[read.44] The read() and pread() functions may fail if:

EIO [read.44.01] A physical I/O error has occurred.

This function performs error detection.

readError : System × N × N → char∗

readError (sys, filedes,nbyte) △

if filedes 6∈ dom sys.fds
then "[EBADFS ]"
else let file = getFile (sys, filedes),

fd = sys.fds (filedes) in
if notValidFDR (sys.tarFileSystem, sys.fds (filedes),file, sys.process (sys.actualproc))
then "[EBADF ]"
else if isDirectory (file)

then "[EISDIR]"
elseif file.attrib.type = r ∧ nbyte > 0 ∧ geMaxOffset (fd)
then "[EOVERFLOW ]"
elseif physicalError (sys)
then "[EIO]"
else [];

This function verifies if the file descriptor is a valid file descriptor open for reading.

notValidFDR : Tar × OpenFileDescriptor × File × ProcInfo → B

notValidFDR (fs, fd, file, pi) △

if fd.file 6∈ dom fs
then true
elseif fd.mode = wr

then true
elseif file.attrib.user = pi.userid

then ¬file.attrib.perm.user .read
elseif file.attrib.group = pi.groupid

then ¬file.attrib.perm.group.read
else ¬ file.attrib.perm.other .read;

This function verifies if the file descriptor refers to a directory.

isDirectory : File → B

isDirectory (file) △

file.attrib.type = d;

This functions verifies if the starting position is greater than or equal to the offset maximum
established in the open file descriptor.

geMaxOffset : OpenFileDescriptor → B

geMaxOffset (ofd) △

ofd.offset > ofd.maxoffset;

This function verify if there is a physical error.

physicalError : System → B

physicalError (sys) △

sys.environment.physicalerror ;
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readFile read contents from file
[read.17] For regular files, no data transfer shall occur past the offset maximum established in

the open file description associated with fildes. [read.11] If any portion of a regular file prior to
the end-of-file has not been written, read() shall return bytes with value 0.

[read.61.02] If ISIG is set, the INTR character shall be discarded when processed. [read.62.02]
If ISIG is set, the QUIT character shall be discarded when processed.

[read.66.01] Special character on input, which is recognized if the ICANON flag is set. Erases
the last character in the current line; see Canonical Mode Input Processing. It shall not erase
beyond the start of a line, as delimited by an NL, EOF, or EOL character. [read.66.02] If ICANON
is set, the ERASE character shall be discarded when processed.

[&&read.66.01] The ERASE character shall delete the last character in the current line, if there
is one. [&&read.67.01] The KILL character shall delete all data in the current line, if there is any.
[&read.66.01] The ERASE and KILL characters shall have no effect if there is no data in the current
line. [&read.67.01] The ERASE and KILL characters shall have no effect if there is no data in the
current line.

OBS: These last requirements are similar to [read.66.01] and [read.67.01]. [&read.66.01]
and [&read67.01] are implemented by [read.66.01] and [read.67.01]. The actions described in
[&&read.66.01] and [&&read.67.01] only ocour if an aditional condition is verified. We choose to
mantain the requirements that have stronger conditions ([read.66.01] and [read.67.01]).

[read.67.01] Special character on input, which is recognized if the ICANON flag is set. Deletes
the entire line, as delimited by an NL, EOF, or EOL character. [&read.67.02] If ICANON is set,
the KILL character shall be discarded when processed.

[read.68.01] Special character on input, which is recognized if the ICANON flag is set. When
received, all the bytes waiting to be read are immediately passed to the process without waiting for a
newline, and the EOF is discarded. Thus, if there are no bytes waiting (that is, the EOF occurred
at the beginning of a line), a byte count of zero shall be returned from the read(), representing an
end-of-file indication. [read.68.02] If ICANON is set, the EOF character shall be discarded when
processed.

[read.63.02] The SUSP character shall be discarded when processed.
[&&read.64.02] If IXON is set, the STOP character shall be discarded when processed.
[read.64.02] When IXON is not set, the START and STOP characters shall be read. [&&read.65.02]

If IXON is set, the START character shall be discarded when processed. [read.65.02] When IXON
is not set, the START and STOP characters shall be read.

[read.64.02] [read.65.02] When IXON is not set, the START and STOP characters shall be
read.

OBS: This requirement is already implemented by [&&read.64.02] and [&&read.65.02]
[read.71.01] Special character on input, which is recognized if the ICANON flag is set; it is the

carriage-return character. [&read.71.02] When ICANON and ICRNL are set and IGNCR is not
set, this character shall be translated into an NL, and shall have the same effect as an NL character.
[read.76.02] If IGNCR is set, a received CR character shall be ignored (not read). [read.76.01] If
INLCR is set, a received NL character shall be translated into a CR character.

[read.71.02] If IGNCR is not set and ICRNL is set, a received CR character shall be translated
into an NL character.

OBS: This requirement is similar to [&read.71.02], but it needs one more condition, so we
decided to implement the last one.

This function read nbyte bytes from the file associated with the open file descriptor, fildes, into
the buffer pointed to by buf.
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readFile : FileContents × FDFlags-set × N × N × N → Byte∗ → Byte∗ × N

readFile (file, flags, pos, maxbytes,maxpos)(ac) △

let mk-FileContents (conts) = file,

mk- (last, -) = lastCont (file) in
if maxbytes = 0 ∨ pos > last ∨

pos > maxpos
then mk- (ac, pos)
else if pos 6∈ dom conts

then readFile (file, flags, pos + 1, maxbytes − 1, maxpos) (ac y [mk-token (0)])
else let x = conts (pos) in

if x = mk-token ("INTR")
then if isFlagSet (flags, ISIG)

then readFile (file, flags, pos + 1, maxbytes − 1, maxpos) (ac)
else readFile (file, flags, pos + 1, maxbytes − 1, maxpos) (ac y [conts (pos)])

elseif x = mk-token ("QUIT")
then if isFlagSet (flags, ISIG)

then readFile (file, flags, pos + 1, maxbytes − 1, maxpos) (ac)
else readFile (file, flags, pos + 1, maxbytes − 1, maxpos) (ac y [conts (pos)])

elseif x = mk-token ("ERASE")
then if isFlagSet (flags, ICANON)

then if len ac > 0 ∧ ac (len ac) 6∈ {mk-token ("NL"),
mk-token ("EOF"),
mk-token ("EOL")}

then readFile (file, flags,pos + 1, maxbytes − 1, maxpos)
(
[ac (i) | i ∈ inds ac · i < len ac])

else readFile (file, flags,pos + 1, maxbytes − 1, maxpos) (ac)
else readFile (file, flags, pos + 1, maxbytes − 1, maxpos) (ac y [conts (pos)])

elseif x = mk-token ("KILL")
then if isFlagSet (flags, ICANON)

then if len ac > 0 ∧ ac (len ac) 6∈ {mk-token ("NL"),
mk-token ("EOF"),
mk-token ("EOL")}

then readFile (file, flags,pos, maxbytes,maxpos)
(
[ac (i) | i ∈ inds ac · i < len ac])

else readFile (file, flags,pos + 1, maxbytes − 1, maxpos) (ac)
else readFile (file, flags, pos + 1, maxbytes − 1, maxpos) (ac y [conts (pos)])

elseif x = mk-token ("EOF")
then if isFlagSet (flags, ICANON)

then mk- (ac, pos + 1)
else readFile (file, flags, pos + 1, maxbytes − 1, maxpos) (ac y [conts (pos)])

elseif x = mk-token ("SUSP")
then if isFlagSet (flags, ISIG)

then readFile (file, flags, pos + 1, maxbytes − 1, maxpos) (ac)
else readFile (file, flags, pos + 1, maxbytes − 1, maxpos) (ac y [conts (pos)])

elseif x = mk-token ("STOP")
then if isFlagSet (flags, IXON)

then readFile (file, flags, pos + 1, maxbytes − 1, maxpos) (ac)
else readFile (file, flags, pos + 1, maxbytes − 1, maxpos) (ac y [conts (pos)])

elseif x = mk-token ("START")
then if isFlagSet (flags, IXON)

then readFile (file, flags, pos + 1, maxbytes − 1, maxpos) (ac)
else readFile (file, flags, pos + 1, maxbytes − 1, maxpos) (ac y [conts (pos)])

elseif x = mk-token ("CR")
then if isFlagSet (flags, ICANON) ∧ isFlagSet (flags, ICRNL) ∧ ¬ isFlagSet (flags, IGNCR)

then readFile (file, flags, pos + 1, maxbytes − 1, maxpos) (ac y [mk-token ("NL")])
elseif isFlagSet (flags, IGNCR)
then readFile (file, flags, pos + 1, maxbytes − 1, maxpos) (ac)
else readFile (file, flags, pos + 1, maxbytes − 1, maxpos) (ac y [conts (pos)])

elseif x = mk-token ("NL")
then if isFlagSet (flags, INLCR)

then readFile (file, flags, pos + 1, maxbytes − 1, maxpos) (ac y [mk-token ("CR")])
else readFile (file, flags, pos + 1, maxbytes − 1, maxpos) (ac y [conts (pos)])

else readFile (file, flags, pos + 1, maxbytes − 1, maxpos) (ac y [conts (pos)]);

This function verify if flag is set.
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isFlagSet : FDFlags-set × FDFlags → B

isFlagSet (flags,flag) △

flag ∈ flags;

2.2.7 Write

write

ssize_t write(int fildes, const void *buf, size_t nbyte);

[write.01] The write() function shall attempt to write nbyte bytes from the buffer pointed to by
buf to the file associated with the open file descriptor, fildes.

[write.02.01] Before any action described below is taken, and if nbyte is zero and the file is a
regular file, the write() function may detect and return errors as described below. [write.02.02] In
the absence of errors, or if error detection is not performed, the write() function shall return zero
and have no other results.

[app.write.03] If nbyte is zero and the file is not a regular file, the results are unspecified.
[write.08.01] If the O APPEND flag of the file status flags is set, the file offset shall be set to

the end of the file prior to each write [write.08.02] no intervening file modification operation shall
occur between changing the file offset and the write operation.

[write.04] On a regular file or other file capable of seeking, the actual writing of data shall
proceed from the position in the file indicated by the file offset associated with fildes. [write.06] On
a regular file, if this incremented file offset is greater than the length of the file, the length of the
file shall be set to this file offset.

[write.05] Before successful return from write(), the file offset shall be incremented by the
number of bytes actually written.

[write.09] If a write() requests that more bytes be written than there is room for (for example,
the process’ file size limit or the physical end of a medium), only as many bytes as there is room
for shall be written.
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write : System × N × N × N → (Z × System)

write (sys, fildes, buf , nbyte) △

let ofd = sys.fds (fildes) in
if (ofd.file 6∈ dom sys.tarFileSystem)
then mk- (nbyte, sys)
else let err = writeError (sys, fildes, nbyte) in

if err 6= []
then mk- (− 1, µ (sys, errno 7→ err))
elseif (nbyte = 0)
then mk- (0, sys)
elseif (sys.tarFileSystem (ofd.file).attrib.type = r)
then let file = sys.tarFileSystem (ofd.file),

attrib = file.attrib in
if (O APPEND ∈ ofd.status)
then if (sys.unusedspace ≥ nbyte)

then let newattrib = µ (attrib,

size 7→ attrib.size + nbyte),
fcont = mk-Tar ‘FileContents (file.contents.content †

prepwrite (sys, buf , nbyte, file.attrib.size)),
newfile = µ (file, attrib 7→ newattrib, contents 7→ fcont),
newsys = µ (sys, unusedspace 7→ (sys.unusedspace −

nbyte), tarFileSystem 7→ sys.tarFileSystem † {ofd.file 7→ newfile}) in
mk- (nbyte, setOffset (newsys, fildes, newfile.attrib.size))

else let newattrib = µ (attrib, size 7→ attrib.size + sys.unusedspace),
fcont = mk-Tar ‘FileContents (file.contents.content †

prepwrite (sys, buf , sys.unusedspace,file.attrib.size)),
newfile = µ (file, attrib 7→ newattrib, contents 7→ fcont),
newsys = µ (sys, unusedspace 7→ 0, tarFileSystem 7→ sys.tarFileSystem †

{ofd.file 7→ newfile}) in
mk- (sys.unusedspace, setOffset (newsys, fildes, newfile.attrib.size))

else let file = sys.tarFileSystem (ofd.file) in
if ofd.offset + nbyte > file.attrib.size
then let diff = ofd.offset + nbyte − file.attrib.size in

if (sys.unusedspace > diff )
then let newattrib = µ (attrib, size 7→ attrib.size + diff ),

fcont = mk-Tar ‘FileContents
(
file.contents.content †

prepwrite (sys, buf , nbyte, ofd.offset)),
newfile = µ (file, attrib 7→ newattrib, contents 7→ fcont),
newsys = µ (sys, unusedspace 7→ (sys.unusedspace − diff ),

tarFileSystem 7→ sys.tarFileSystem † {ofd.file 7→
newfile}) in

mk- (nbyte, setOffset (newsys, fildes, newfile.attrib.size))
else let newattrib = µ (attrib, size 7→ attrib.size + sys.unusedspace),

fcont = mk-Tar ‘FileContents (file.contents.content †
prepwrite (sys, buf , sys.unusedspace,ofd.offset)),

newfile = µ (file, attrib 7→ newattrib, contents 7→ fcont),
newsys = µ (sys, unusedspace 7→ 0,

tarFileSystem 7→ sys.tarFileSystem † {ofd.file 7→
newfile}) in

mk- (sys.unusedspace, setOffset (newsys, fildes, newfile.attrib.size))
else let newattrib = µ (attrib, size 7→ attrib.size + nbyte),

fcont = mk-Tar ‘FileContents (file.contents.content †
prepwrite (sys, buf , nbyte, ofd.offset)),

newfile = µ (file, attrib 7→ newattrib, contents 7→ fcont),
newsys = µ (sys, tarFileSystem 7→ sys.tarFileSystem † {ofd.file 7→

newfile}) in
mk- (nbyte, setOffset (newsys, fildes, ofd.offset + nbyte))

else mk- (0, sys);

Auxiliary functions Used to create the segment of memory that will written in the file contents.
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prepwrite : Tar ‘System × N × N × N → Tar ‘Memory

prepwrite (sys, buf , nbyte, offset) △

let addrs = mkaddrlist (buf , buf + nbyte),
fileaddr = mkaddrlist (offset, offset + nbyte),
array = prepwriteaux (sys, addrs) in

addrArray2Memory (fileaddr , array);

addrArray2Memory : N
∗ × Tar ‘Byte∗ → Tar ‘Memory

addrArray2Memory (addrs, array) △

if addrs = []
then {7→}
else {hd addrs 7→ hd array} † addrArray2Memory (tl addrs, tl array)

pre len array ≥ len addrs
;

prepwriteaux : Tar ‘System × N
∗ → Tar ‘Byte∗

prepwriteaux (sys, l) △

cases l :
[] → [],
[h] y t → if (h ∈ dom sys.memory)

then [sys.memory (h)] y prepwriteaux (sys, t)
else [mk-token ("TRASH")] y prepwriteaux (sys, t)

end;

mkaddrlist : N × N → N
∗

mkaddrlist (b, n) △

if b = n
then []
else [b] y mkaddrlist (b + 1, n)

pre n ≥ b
;

writeError This function perform error detection
[write.41] The write() and pwrite() functions shall fail if:

EBADF [write.41.02] The fildes argument is not a valid file descriptor open for writing.

EFBIG [write.41.04] The file is a regular file, nbyte is greater than 0, and the starting position is
greater than or equal to the offset maximum established in the open file description associated
with fildes.

EINTR [write.41.05] The write operation was terminated due to the receipt of a signal, and no
data was transferred.

ENOSPC [write.41.07] There was no free space remaining on the device containing the file.

[write.43] The write() and pwrite() functions may fail if:

EIO [write.43.02] A physical I/O error has occurred.

ENOBUFS [write.43.03] Insufficient resources were available in the system to perform the oper-
ation.

[write.44] The write() function may fail if:

EACCES [write.44.01] A write was attempted on a socket and the calling process does not have
appropriate privileges.
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writeError : System × N × N → char∗

writeError (sys, fildes,nbyte) △

if (write4102 (sys, fildes))
then "[EBADF ]"
elseif (write4104 (sys, fildes, nbyte))
then "[EFBIG]"
elseif (write4105 (sys))
then "[EINTR]"
elseif (write4107 (sys, fildes, nbyte))
then "[ENOSPC ]"
elseif (write4302 (sys))
then "[EIO]"
elseif (write4303 (sys))
then "[ENOBUFS ]"
elseif (write4401 (sys, fildes))
then "[EACCES ]"
else [];

[write.41.02] [EBADF] The fildes argument is not a valid file descriptor open for writing.

write4102 : Tar ‘System × N → B

write4102 (sys, fd) △

fd 6∈ dom sys.fds ∨
if (fd ∈ dom sys.fds)
then sys.fds (fd).mode = rd

else false;

[write.41.04] [EFBIG] The file is a regular file, nbyte is greater than 0, and the starting position
is greater than or equal to the offset maximum established in the open file description associated
with fildes.

write4104 : Tar ‘System × N × N → B

write4104 (sys, fildes, nbyte) △

let ofd = sys.fds (fildes) in
sys.tarFileSystem (ofd.file).attrib.type = r ∧
nbyte > 0 ∧
ofd.offset ≥ ofd.maxoffset

pre fildes ∈ dom sys.fds

;

[write.41.05] [EINTR] The write operation was terminated due to the receipt of a signal, and
no data was transferred.

write4105 : Tar ‘System → B

write4105 (sys) △

sys.environment.signal;

[write.41.07] [ENOSPC] There was no free space remaining on the device containing the file.

write4107 : Tar ‘System × N × N → B

write4107 (sys, fildes, nbyte) △

let ofd = sys.fds (fildes) in
if (O APPEND ∈ ofd.status ∧ nbyte > 0)
then sys.unusedspace = 0
elseif ofd.offset + nbyte > sys.tarFileSystem (ofd.file).attrib.size

then sys.unusedspace = 0
else false

pre fildes ∈ dom sys.fds ∧
sys.fds (fildes).file ∈ dom sys.tarFileSystem

;

[write.41.08] [EPIPE] An attempt is made to write to a pipe or FIFO that is not open for
reading by any process, or that only has one end open. A SIGPIPE signal shall also be sent to the
thread.

Department of Informatics 32 University of Minho



Verified File-System v1.0

write4108 : Tar ‘System × N → B

write4108 (sys, fildes) △

let ofd = sys.fds (fildes) in
sys.tarFileSystem (ofd.file).attrib.type = p ∧
¬∃ ofds ∈ rng sys.fds · ofds.file = ofd.file ∧ ofds.mode = rd

pre fildes ∈ dom sys.fds

;

[write.43.02] [EIO] A physical I/O error has occurred.

write4302 : Tar ‘System → B

write4302 (sys) △

sys.environment.physicalerror ;

[write.43.03] [ENOBUFS] Insufficient resources were available in the system to perform the
operation.

write4303 : Tar ‘System → B

write4303 (sys) △

sys.environment.unable2resorces;

[write.44.01] [EACCES] A write was attempted on a socket and the calling process does not
have appropriate privileges.

write4401 : Tar ‘System × N → B

write4401 (sys, fildes) △

let path = sys.fds (fildes).file in
(sys.tarFileSystem (path).attrib.type = s ∧
let proc = sys.process (sys.actualproc) in
checkWritePerm (path, sys.tarFileSystem, proc.userid,proc.groupid))

pre fildes ∈ dom sys.fds

;

2.3 Auxiliary Functions

2.3.1 Init

This function produces a value of the type System and it’s used to initialize the Tar Object.

init : () → System

init () △

let contents = mk-Tar ‘FileContents ({0 7→ ’a’}),
permissions = mk-Tar ‘FilePermissions

(
mk-Tar ‘Permissions (true, true, true), mk-Tar ‘Permissions (true, true, true), mk-Tar ‘Permissions (true,

fileattrib = mk-Tar ‘Attributes (r, permissions, 1, 1, 7, 1, mk-Tar ‘Dates (mk-Tar ‘Date (mk-token ("1999"), false), mk-Tar ‘Date (
file = mk-Tar ‘File (fileattrib, contents),
dir = mk-Tar ‘File (mk-Tar ‘Attributes (d, permissions, 0, 1, 7, 0, mk-Tar ‘Dates (mk-Tar ‘Date (mk-token ("1999"), false), mk-Tar

tar = {mk-Tar ‘Path ([]) 7→ dir ,

mk-Tar ‘Path (["Desktop"]) 7→ dir ,

mk-Tar ‘Path (["Desktop", ".DS Store"]) 7→ file,

mk-Tar ‘Path (["Desktop", "CV sergio.pdf "]) 7→ file},

proc = {1 7→ mk-Tar ‘ProcInfo (1, 7, permissions, {0})},

ofd = mk-Tar ‘OpenFileDescriptor (mk-Tar ‘Path (["Desktop", "CV sergio.pdf "]), {O APPEND}, 0, 99999999, {}, rdwr),
constants = {"{SYMLOOP MAX}" 7→ 20, "{LINK MAX}" 7→ 10, "{PATH MAX}" 7→

20, "{NAME MAX}" 7→ 256, "{MAX OFFSET}" 7→ 1024,

"{MAX OPEN SYSTEM}" 7→ 20, "{MAX OFF T}" 7→
2048, "{OPEN MAX}" 7→ 5, "SSIZE MAX" 7→ 10} in

mk-Tar ‘System (tar , proc, {0 7→ ofd}, 1, constants, [], 100000, mk-Tar ‘Environment (false, false, false, false, rdwr, false),
{1 7→ ’h’, 2 7→ ’e’, 3 7→ ’l’, 4 7→ ’l’, 5 7→ ’o’}, {7→});
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2.3.2 mode2perm

This function transforms the mode t flags to the correspondent FilePermissions

mode2perm : Mode-t-set → FilePermissions

mode2perm (smode) △

mk-FilePermissions (usermode (smode), groupmode (smode),othersmode (smode));

usermode : Mode-t-set → Permissions

usermode (modes) △

if (S IRWXU ∈ modes)
then mk-Permissions (true, true, true)
else mk-Permissions (S IRUSR ∈ modes,S IWUSR ∈ modes,S IXUSR ∈ modes);

groupmode : Mode-t-set → Permissions

groupmode (modes) △

if (S IRWXG ∈ modes)
then mk-Permissions (true, true, true)
else mk-Permissions (S IRGRP ∈ modes,S IWGRP ∈ modes,S IXGRP ∈ modes);

othersmode : Mode-t-set → Permissions

othersmode (modes) △

if (S IRWXO ∈ modes)
then mk-Permissions (true, true, true)
else mk-Permissions (S IROTH ∈ modes,S IWOTH ∈ modes,S IXOTH ∈ modes);

2.3.3 Various

These are some needed, but self-explaining functions
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take : Z × Tar ‘Path → Tar ‘Path

take (n, p) △

mk-Tar ‘Path ([p.path (i) | i ∈ inds p.path · i ≤ n])
pre n ≤ len p.path

;

subpaths : Tar ‘Path → Tar ‘Path-set
subpaths (p) △

{take (n − 1, p) | n ∈ inds p.path · n > 0};

blast : Tar ‘Path → Tar ‘Path

blast (p) △

take ((len p.path) − 1, p)
pre p.path 6= []

;

last : Tar ‘Path → Tar ‘Id

last (mk-Tar ‘Path (p)) △

p ((len p))
pre p 6= []

;

drop : Z × Tar ‘Path → Tar ‘Path

drop (n, p) △

mk-Tar ‘Path ([p.path (i) | i ∈ inds p.path · i > n]);

lastCont : FileContents → N × Byte

lastCont (fc) △

let pos = max (dom fc.content) in
mk- (pos, fc.content (pos));

max : N-set → N

max (s) △

if card s = 1
then let {x} = s in

x
else let x ∈ s in

if x > max (s \ {x})
then x
else max (s \ {x})

pre card s > 0
;

2.3.4 checkExecPerm

Verifies if a process has search/execution permission on a file
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checkExecPerm : Tar ‘Path × Tar ‘Tar × Tar ‘UserId × Tar ‘GroupId → B

checkExecPerm (path, tar , uid, gid) △

userExecPerm (path, tar , uid) ∨ groupExecPerm (path, tar , gid) ∨ otherExecPerm (path, tar)
pre path ∈ dom tar

;

userExecPerm : Tar ‘Path × Tar ‘Tar × Tar ‘UserId → B

userExecPerm (path, tar , uid) △

if (tar (path).attrib.user = uid)
then tar (path).attrib.perm.user .exec

else false
pre path ∈ dom tar

;

groupExecPerm : Tar ‘Path × Tar ‘Tar × Tar ‘GroupId → B

groupExecPerm (path, tar , gid) △

if (tar (path).attrib.group = gid)
then tar (path).attrib.perm.group.exec

else false
pre path ∈ dom tar

;

otherExecPerm : Tar ‘Path × Tar ‘Tar → B

otherExecPerm (path, tar) △

tar (path).attrib.perm.other .exec

pre path ∈ dom tar

;

2.3.5 checkWritePerm

Verifies if a process has write permission on a file

checkWritePerm : Tar ‘Path × Tar ‘Tar × Tar ‘UserId × Tar ‘GroupId → B

checkWritePerm (path, tar , uid, gid) △

userWritePerm (path, tar , uid) ∨ groupWritePerm (path, tar , gid) ∨ otherWritePerm (path, tar)
pre path ∈ dom tar

;

userWritePerm : Tar ‘Path × Tar ‘Tar × Tar ‘UserId → B

userWritePerm (path, tar , uid) △

if (tar (path).attrib.user = uid)
then tar (path).attrib.perm.user .write

else false
pre path ∈ dom tar

;

groupWritePerm : Tar ‘Path × Tar ‘Tar × Tar ‘GroupId → B

groupWritePerm (path, tar , gid) △

if (tar (path).attrib.group = gid)
then tar (path).attrib.perm.group.write

else false
pre path ∈ dom tar

;

otherWritePerm : Tar ‘Path × Tar ‘Tar → B

otherWritePerm (path, tar) △

tar (path).attrib.perm.other .write

pre path ∈ dom tar
;

2.3.6 checkReadPerm

Verifies if a process has read permission on a file
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checkReadPerm : Tar ‘Path × Tar ‘Tar × Tar ‘UserId × Tar ‘GroupId → B

checkReadPerm (path, tar , uid, gid) △

userReadPerm (path, tar , uid) ∨ groupReadPerm (path, tar , gid) ∨ otherReadPerm (path, tar)
pre path ∈ dom tar

;

userReadPerm : Tar ‘Path × Tar ‘Tar × Tar ‘UserId → B

userReadPerm (path, tar , uid) △

if (tar (path).attrib.user = uid)
then tar (path).attrib.perm.user .read

else false
pre path ∈ dom tar

;

groupReadPerm : Tar ‘Path × Tar ‘Tar × Tar ‘GroupId → B

groupReadPerm (path, tar , gid) △

if (tar (path).attrib.group = gid)
then tar (path).attrib.perm.group.read

else false
pre path ∈ dom tar

;

otherReadPerm : Tar ‘Path × Tar ‘Tar → B

otherReadPerm (path, tar) △

tar (path).attrib.perm.other .read

pre path ∈ dom tar

;

2.3.7 checkRDOnly

Verifies if a process has read permission on a file

checkRDOnly : Tar ‘Path × Tar ‘Tar × Tar ‘UserId × Tar ‘GroupId → B

checkRDOnly (path, tar , -, -) △

let perm = tar (path).attrib.perm in
¬ (perm.user .write ∨ perm.group.write ∨ perm.other .write)

pre path ∈ dom tar

;

2.3.8 checkFilePerm

Verifies if a process has permission to access a file

checkFilePerm : System × Tar ‘Path × Flags-set → B

checkFilePerm (sys, path, flags) △

let proc = sys.process (sys.actualproc) in
if (O RDONLY ∈ flags)
then checkReadPerm (path, sys.tarFileSystem, proc.userid,proc.groupid)
else if (O WRONLY ∈ flags)

then checkWritePerm (path, sys.tarFileSystem, proc.userid,proc.groupid)
else checkReadPerm (path, sys.tarFileSystem, proc.userid,proc.groupid) ∧

checkWritePerm (path, sys.tarFileSystem, proc.userid,proc.groupid)
pre path ∈ dom sys.tarFileSystem

;

2.3.9 Setters and Getters

Gets the file contents associated with a file descritor.
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getFileContents : System × N → FileContents

getFileContents (sys, filedes) △

getFile (sys, filedes).contents

pre filedes ∈ dom sys.fds ∧
getFile (sys, filedes).attrib.type = r

;

Gets the file associated with a file descriptor.

getFile : System × N → File

getFile (sys, filedes) △

let path = sys.fds (filedes).file in
sys.tarFileSystem (path)

pre filedes ∈ dom sys.fds

;

Gets the offset associated with a file descriptor.

getOffset : System × N → N

getOffset (sys, filedes) △

sys.fds (filedes).offset

pre filedes ∈ dom sys.fds
;

Gets the offset maximum associated with a file descriptor.

getMaxOffset : System × N → N

getMaxOffset (sys, filedes) △

sys.fds (filedes).maxoffset

pre filedes ∈ dom sys.fds
;

Gets the path associated with a file descriptor.

getPath : System × N → Path

getPath (sys, filedes) △

sys.fds (filedes).file

pre filedes ∈ dom sys.fds

;

Sets system ’errno’ variable.

setErrno : System × char∗ → System

setErrno (sys, err) △

µ (sys, errno 7→ err);

Sets a file descriptor ’st atime’ flag to false.

setSt-ATime : System × N → System

setSt-ATime (sys, filedes) △

let mk-System (fs, procs, fds, aprocs, c, errno, us, en, mem,dev) = sys,

path = fds (filedes).file,

mk-File (attribs, conts) = fs (path),
mk-Attributes (type, perm, links, user , group, size, dates) = attribs,

mk-Dates (st-atime, st-ctime, st-mtime) = dates,

ndates = mk-Dates (mk-Date (st-atime.date, false), st-ctime, st-mtime),
nattribs = mk-Attributes (type, perm, links, user , group, size, ndates),
nfile = mk-File (nattribs, conts) in

mk-System (fs † {path 7→ nfile}, procs, fds, aprocs, c, errno, us, en, mem,dev)
pre filedes ∈ dom sys.fds

;

Department of Informatics 38 University of Minho



Verified File-System v1.0

Sets a file descriptor offset.

setOffset : System × N × N → System

setOffset (sys, filedes,newos) △

let mk-System (fs, procs, fds, aprocs, c, errno, us, en, mem,dev) = sys,

mk-OpenFileDescriptor (p, s, -, mo, f , md) = fds (filedes),
newfd = mk-OpenFileDescriptor (p, s, newos, mo, f , md),
newfds = fds † {filedes 7→ newfd} in

mk-System (fs, procs,newfds, aprocs,c, errno, us, en, mem,dev)
pre filedes ∈ dom sys.fds

;

Puts data in system memory.

setMemory : System × N × Byte∗ → System

setMemory (sys, startd, data) △

let mk-System (fs, procs, fds, aprocs, c, errno, us, en, mem,dev) = sys,

newmem = mem † {(startd + i − 1) 7→ data (i) |
i ∈ inds data} in

mk-System (fs, procs, fds, aprocs, c, errno, us, en, newmem,dev);

2.3.10 applyMask

A bitwise AND is performed on the file-mode bits and the corresponding bits in the complement
of the process’ file mode creation mask. Thus, all bits in the file mode whose corresponding bit in
the file mode creation mask is set are cleared.

applyMask : Tar ‘FilePermissions × Tar ‘FilePermissions → Tar ‘FilePermissions

applyMask (perm,umask) △

let user = mk-Tar ‘Permissions (perm.user .read ∧ ¬ umask .user .read,perm.user .write ∧
¬ umask .user .write, perm.user .exec ∧ ¬ umask .user .exec),

group = mk-Tar ‘Permissions (perm.group.read ∧ ¬ umask .group.read,perm.group.write ∧
¬ umask .group.write, perm.group.exec ∧ ¬ umask .group.exec),

other = mk-Tar ‘Permissions (perm.other .read ∧ ¬ umask .other .read,perm.other .write ∧
¬ umask .other .write, perm.other .exec ∧ ¬ umask .other .exec) in

mk-Tar ‘FilePermissions (user , group,other)

2.4 Objectifying

After we had resolved all our problems with a functional flavor, we use that functions to build
an object. It’s very simple to do this, we just have to an instance variable of type System and
apply our functions to it with the correct arguments.
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end Tar

class TarObj is subclass of Tar
instance variables
system : System := init ();

Mkdir : Path × Mode-t-set
o
→ Z

Mkdir (path, mode) △

def r = mkdir (path, mode, system) in
( system := r .#2;

return r .#1
);

Open : Path × Flags-set × Mode-t-set
o
→ Z

Open (path, flags, mode) △

def r = open (path, flags, mode, system) in
( system := r .#2;

return r .#1
);

Write : N × N × N
o
→ Z

Write (fildes, buf , nbyte) △

def r = write (system, fildes, buf , nbyte) in
( system := r .#2;

return r .#1
);

Read : N × N × N
o
→ Z

Read (fildes, buf , nbyte) △

def r = read (system, fildes, buf , nbyte) in
( system := r .#2;

return r .#1
)

end TarObj

2.5 Testing

Our model was not extensively tested, not only because of lack of time but also because it was
a bit dificult to see the outcome when using a realistic size file system.

Anyway, as a tool to help in testing, we developed a Haskell script that scans a directory
and recursively its sub-directories to produce a Tar VDM type. We recommend its use in future
developments of this project, as it is very easy to use: just run it, choose which directory to scan
and then choose a file for the output to be written.

3 Conclusion

With this work we hope to have set the ground for a VDM specification of a POSIX-like file
system. We have implemented a data type and some basic operations to suport the file system
modus operandi. For this purpose, we followed a list of requirements for each function developed
by the Open Linux Verification. It has not been possible to model all the requirements because
(a) in some cases because it wouldn’t be possible to do it with VDM itself; (b) in other cases, lack
of time led us to decide not to make the model too complex. Overcoming these limitations is work
for the future.

Concerning basic data type definitions, we first thought in some invariants that would prevent
some errors from happening, for instance preventing that a link points to a file that doesn’t exist,
or that only files that exist are associated with a file descriptor. These invariants would turn the
file system safer but they weren’t mentioned in any specification, so we didn’t introduce them
because we didn’t want to ”narrow” the problem.

In modelling the functionality we had to take decisions wherever requirements weren’t clear.
Some other times there were requirements that overlapped others. These situations are properly
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mentioned in the report.
One of the great dificulties of this work was to choose a standard requirements document to

follow. This happened because of some involved aspects that weren’t possible to implement, or of
requirements that were missing, or even because almost all of them had parts that weren’t very
clear.

Although there are lots of aspects to improve, considering the dimension of the project and
the time avaiable, we think that in general the outcome is positive. This has helped us in seeing
how to approach big sized problems from a formal point of view.

The effort put into this assignment was roughly 100 hours of work.
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